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Introduction 
The Compliance Monitoring Data Portal (CMDP) is an online reporting application that allows accredited 
laboratories and public water systems (PWSs) to report safe drinking water compliance monitoring data directly to 
the Texas Commission on Environmental Quality (TCEQ) Public Water System Supervision Program (PWSSP). The 
CMDP is maintained by the Environmental Protection Agency (EPA) and is available in two environments: Pre-
Production (Testing) and Production (Compliance). 

This quick reference guide is not intended to be a complete user instruction manual. It has been designed to provide 
supplemental instructions to the materials available on the EPA Compliance Monitoring Data Portal (CMDP) Support 
website. It also provides clarification for reporting requirements specific to Texas. Additional information is available 
on the TCEQ PWSSP Website. 

CMDP State Administrators 
Please contact CMDPADM@tceq.texas.gov if you have any questions or need assistance. 

Overview 

CMDP Support Website 
EPA maintains a CMDP Support website to provide training materials and a knowledge base to assist all CMDP users. 
EPA also uses the website to provide important announcements related to new releases of the CMDP and release 
notes describing the recent enhancements to the application.  

CMDP Reporting Options  
The CMDP offers reporting flexibility by providing several options for reporting compliance data. Users can use any 
combination of the following methods to report compliance data to the TCEQ Public Water System Supervision 
Program: 

Online Data Entry (Web Forms) – Users can enter compliance data directly into online forms and submit the data 
through the CMDP. Use of the Online Data Entry forms is documented in the CMDP User Manual on the CMDP 
Support website.  

Microsoft Excel Templates – Microsoft Excel templates can be downloaded directly from the CMDP. Users can enter 
compliance data into the template and generate a properly formed XML file that can be manually uploaded into the 
CMDP. The forms are updated occasionally for enhancement or to address bugs. Always be sure to use the latest 
worksheets when using this reporting option.  

XML File Uploads – XML files can be generated directly from a user’s data system [i.e., Laboratory Information 
System (LIMS)]and manually uploaded into the CMDP. Information related to the structure and requirements of the 
CMDP XML Schema is available in the CMDP Web Services Sampling XML Schema Definitions. 

Web Services – XML files can be generated directly from a user’s data system [i.e., Laboratory Information System 
(LIMS)] and be automatically uploaded into the CMDP using Web Services. Information related to the CMDP XML 
Schema and the use of Web Services is available in the CMDP Web Services Sampling XML Schema Definitions and 
the CMDP-LIMS Interface Control Document.  

  

https://usepa.servicenowservices.com/sdwisprogram
https://www.tceq.texas.gov/drinkingwater/pwss.html
mailto:CMDPADM@tceq.texas.gov
https://usepa.servicenowservices.com/sdwisprogram
https://usepa.servicenowservices.com/sdwisprogram/en/compliance-monitoring-data-portal-user-manual?sys_kb_id=35d5560f1b459558cb91a759bc4bcb81&id=kb_article_view&sysparm_rank=1&sysparm_tsqueryId=ed8aa976973ac290ef92fd9ad053af1f
https://usepa.servicenowservices.com/sdwisprogram/en/cmdp-web-services-sampling-xml-schema-definitions?id=kb_article&sysparm_article=KB0015318&sys_kb_id=64e2d60b1b459558cb91a759bc4bcba6&spa=1
https://usepa.servicenowservices.com/sdwisprogram/en/cmdp-web-services-sampling-xml-schema-definitions?id=kb_article&sysparm_article=KB0015318&sys_kb_id=64e2d60b1b459558cb91a759bc4bcba6&spa=1
https://usepa.servicenowservices.com/sdwisprogram/en/cmdp-lims-interface-control-document?sys_kb_id=bb8012871b459558cb91a759bc4bcb6b&id=kb_article_view&sysparm_rank=1&sysparm_tsqueryId=b90010151bb2cad879ab0f67624bcbef
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CMDP Environments 
There are two CMDP environments available: Pre-Production (Testing) and Production (Compliance).  

CMDP Pre-Production 

All users will begin using the CMDP in the Pre-Production (Testing) environment. The Pre-Production environment 
allows users to get familiar with the CMDP and serves as a testing ground to verify that online forms are completed 
correctly, data from Excel templates is complete, and all XML files submitted for compliance are well-formed and 
accurate. CMDP Pre-Production provides all the functionality of CMDP Production, but it delivers data to a 
staging/test version of the PWSSP’s Safe Drinking Water Information System/State Version (SDWIS/State).  

CMDP Pre-Production Website: https://cmdpprep.epa.gov/. 

Note: State CMDP Administrators will only approve users that have successfully submitted data using CMDP 
Pre-Production. 

Data reported through CMDP Pre-Production will NOT be used for compliance purposes. 

CMDP Production 

The CMDP Production environment is used to report actual compliance monitoring data to the PWSSP. The data is 
delivered directly to the production version of the PWSSP’s SDWIS/State where it is used to determine water system 
compliance with monitoring and reporting, maximum contaminant levels and treatment technique regulatory 
requirements.  

Once a lab has been notified of CMDP Production approval, and has set up a lab administrator account, all samples 
must be reported using CMDP Production. It is the responsibility of the lab to ensure samples are submitted 
correctly. Samples submitted via CMDP Pre-Production will not be accepted for compliance and, if resubmitted after 
the compliance deadline, will be considered late. The public water system for which the lab is reporting may receive 
monitoring and reporting (M/R) violations. 

Labs may retain access to CMDP Pre-production for training purposes. TCEQ does not monitor submissions in Pre-
Production for labs approved to report in CMDP Production. 

Access to Additional Reporting methods will be removed: 

• Electronic Environmental (E2) Drinking Water Reporting (DWR) System/State of Texas 
Environmental Electronic Reporting System (STEERS) access will be removed for microbial 
reporting. 

• Electronic Data Deliverables (EDDs) will no longer be accepted. 

CMDP Production Website: https://cmdp.epa.gov/. 

Data reported through CMDP Production will be used for compliance purposes. 

Path to Production 
All laboratory and Public Water System CMDP System Administrators must be approved by a State CMDP 
Administrator before accessing the CMDP. Users will be invited to register for CMDP Pre-Production and complete 
the recommended testing before receiving approval to report compliance data through CMDP Production. Section 
2.3 - Private Lab or PWS CMDP Administrator (Sponsor) Registration Sequence of the CMDP Role Registration User 
Guide provides a step-by-step registration sequence for lab and PWS Administrators. Lab and PWS CMDP 

https://cmdpprep.epa.gov/
https://cmdp.epa.gov/
https://usepa.servicenowservices.com/sdwisprogram?id=kb_article_view&sysparm_article=KB0015307
https://usepa.servicenowservices.com/sdwisprogram?id=kb_article_view&sysparm_article=KB0015307
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Administrators will then be able to approve additional CMDP Preparers, Reviewers or Certifier/Submitters for their 
organizations following Section 2.4 - PWS and Private Lab Preparer, Reviewer, and State Lab Submitter Registration 
Sequence of the CMDP Role Registration User Guide.  

CMDP Pre-Production users with either a laboratory, PWS administrator role, or the certifier role will be required to 
submit three error-free sample results for each analyte, or analyte group, that they report to TCEQ. Submissions are 
recommended to reflect similar file size, sample types, and frequency as results sent to TCEQ prior to CMDP. Before 
registering for CMDP Production, labs must demonstrate the ability to accurately report the following types of 
samples using their accredited or approved analytical methods: 

• Routine Chemical/Radiological Samples 
• DBPs, IOCs, SOCs, VOCs, Total Organic Carbon (TOCs), and Nitrates.  
• Routine Lead and Copper Tap Samples 
• Routine Water Quality Parameter Samples 
• Routine Optimal Water Quality Parameter Samples 
• Routine Microbial Samples (i.e., negative samples, total coliform positive, and E. coli positive 

samples) 
• Repeat Microbial Samples 
• Raw Well Microbial Samples (i.e., negative samples, total coliform positive, and E. coli positive 

samples) 
• Triggered Microbial Samples 
• Additional Microbial Samples (i.e., special) 

Note: Only the applicable analyses conducted, and sample types reported by the lab will be required. 

Upon successfully testing and demonstrating that accurate compliance monitoring data can be reported using 
CMDP Pre-Production, lab and PWS Administrators will be invited to register for CMDP Production. All users without 
a Shared CROMERR Services (SCS) account will follow the same process to register for CMDP Production and will 
create a new SCS account. Users with an existing SCS account will add TCEQ to their existing SCS account. The lab or 
PWS Administrator will coordinate with a State CMDP Administrator to establish a final date to switch from reporting 
data with the existing reporting procedure to reporting through CMDP Production. 

https://usepa.servicenowservices.com/sdwisprogram/en/cmdp-role-registration-user-guide?id=kb_article_view&sysparm_article=KB0015307
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User Account Management 

All user management activities are performed using the EPA SCS website.  

After logging into SCS, users are presented with a dashboard displaying all the partners and program services 
available. In SCS, users can view the Partners, Roles, and Organizations that they are associated with and maintain 
user profile information. User accounts must not be shared between individuals. Each member of an organization 
must have a separate account. 

SCS Environments 
The Pre-Production environment is used to maintain user credentials to access Pre-Production CMDP. The 
Production environment is used to maintain user credentials to access Production CMDP. These credentials are not 
interchangeable.  

• SCS Pre-Production Website: https://encromerrtest.epacdxnode.net 
• SCS Production Website: https://cmdp.epa.gov/ 

Figure 1. SCS Homepage 

 

               

               

 

 

https://encromerrtest.epacdxnode.net/
https://cmdp.epa.gov/
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User Profiles 

User profiles can be accessed through the “Profile” hyperlink at the top of the “Program Services” grid.  

Security Questions 

Security questions are used to verify the identity of the user when recovering an account after a password expires. 
Users should carefully select appropriate security questions and remember the responses provided. 

  

Figure 2. SCS Dashboard – Accessing Profile Information 

Figure 3. User Profile Screen 
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Changing Passwords 

User passwords expire every 90 days. Users will begin receiving messages in the Notifications area on the Dashboard 
screen when the password is within 14 days of the expiration date. The password can be updated by clicking on the 
Change Password hyperlink on the user profile screen. To update the password, users will be prompted to enter the 
current password and a new password. New passwords must not contain any special characters. 

If a password expires, users will no longer be able to log into CMDP or SCS. Users should use the Forgot Password 
hyperlink on the SCS log in screen to recover the account and follow the prompts to update the password.  

Note: If a user attempts to log into CMDP directly with an expired password, the log-in will fail, however a 
failure message will not be displayed. The password should be reset using the Forgot Password function on 
the SCS log in screen. 

Signature Questions 

Signature questions are used when a user attempts to certify and submit sample jobs in CMDP. Before submittal, the 
user will be prompted to answer one of the three signature questions. Users should carefully select appropriate 
signature questions and remember the responses provided. Failure to set up the signature questions or answer a 
question successfully during the certify and submit process will result in the inability to successfully report data. 

Using the Compliance Monitoring Data Portal 
This section summarizes how to enter sample data, check for errors, and review, certify, and submit jobs to the State 
using the online data entry form. Submissions, or samples missing TCEQ required fields, are subject to rejection by 
the lab or TCEQ. CMDP and EPA require specific fields to be populated to report through CMDP and into the Safe 
Drinking Water Information System (SDWIS). TCEQ may require additional fields to be reported for compliance 
purposes. All fields are required unless it is noted otherwise.  

Creating a Job 

1. Click on the “Drinking Water Sample Jobs” tab at 
the top of the screen. 

2. Click on the “Create New Job” button at the top of 
the “Drinking Water Samples Jobs” grid. 

3. Click on “Enter a Group of Samples” on the 
“Create New Job Options” pop up screen. 

4. Enter a job description and click on the “OK” 
button. This can be anything that will help the 
user identify the job. A new job will be created, 
and a “Job Summary View” tab will be opened. 

  

Figure 4. Create new Job Screen for Entering Samples Manually 
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Entering Data Using Online Data Entry Forms 
The portion displayed at the top of the data entry form is shown below, along with definitions of the data entry 
requirements per CMDP. Refer to the following sections’ field requirements per TCEQ. 

 
Figure 5. Field Requirements Key 

* - Required: Identifies fields that must contain information to save the sample. 
+ - Conditionally Required: Identifies fields that must contain data if certain conditions are met (For 
example, reporting a Count, Units and Volume if an enumeration analytical method is used) 
f – Federally Required: Identifies fields that must contain data. These fields are used to determine if a 
sample can be used for compliance. 
f – Federally Conditionally Required: Identifies fields that must contain data if certain conditions are met. 
These fields are used to determine if a sample can be used for compliance. 

Entering Microbial Samples 

1. In the “Job Summary View” tab, click on the “Add” dropdown box and choose “Microbial” from the list. 

Sample Information 

1. Enter the information as described below:  

Figure 6. Job Summary View – Adding Micro Samples 

 

Figure 7. Microbial Sample Entry Page 
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a. Water System Id (Required): The seven-digit public water system ID number (PWS ID). This must be 
preceded by TX, which is automatically added by CMDP. Type it in or select from the dropdown list.  

b. Water System Name (Required): The water system name will automatically populate once the PWS ID 
has been entered.  

c. Facility (Required): Water system facility ID number. Select from the dropdown list:  
• DS01 – distribution samples, or  
• Well ID - G1234567A only for raw well samples. 

d. Sampling Point (Required): Sampling point where the sample was collected. Select from the 
dropdown list: 
• From DS01: 

• DSTCRRT if sample type is routine, 
• DSTCRRP if sample type is repeat,  
• DSTCRSP if sample type is special,  

• From Well ID 
• ASM for raw well assessment source monitoring,  
• TSM for raw well triggered source monitoring (collected in response to a total coliform positive 

distribution sample).  
e. Sampling Location (Required): Description of the sampling location (For example, 123 Main St; Health 

Clinic, kitchen sink, etc.). 
f. Sample ID (Required): Sample identification number assigned by the lab. This field is limited to 20 

characters and only numbers, letters, dash (-), and/or underscore. Note: The sample ID must be unique 
based on the lab, date, and PWS ID. 

g. Collection Date (Required): Date (MM/DD/YYYY) the sample was collected. 
h. Collection Time (24-hr) (Required): Time (HH:MM) the sample was collected. 
i. Sample Received Date (Required): Date (MM/DD/YYYY) the sample was received by the laboratory. 
j. Laboratory ID – Name (Required): ID (i.e., T123456789) and name of the lab reporting the sample. 
k. Sample Type (Required): Sample type routine, repeat, triggered, or special. See the “Repeat and 

Triggered Microbial Samples” subsection for details on the additional information required for these 
sample types. Ideally, this information would be identified by the sampler. 
• Routine - routine distribution sample collected to fulfill the monthly coliform TCEQ requirement or 

routine raw well sampling for assessment source monitoring,  
• Repeat - repeat distribution sample collected in response to a routine coliform positive sample,  
• Triggered - raw well samples collected in response to a routine coliform positive sample collected 

in distribution.  
• Special – can be used to rescind a boil water notice, as investigative sampling, to meet TCEQ 

seasonal start up requirements, after well disinfection. Special samples cannot be used to meet 
routine, repeat, or triggered sample requirements.  

l. Sample Volume (ML) (Required): Enter the volume of the sample in MLs, for example 100 for microbial 
samples. 

m. Sample Collector Name (Required): Name of the sample collector.  
n. Comment: Comments about the sample. (Not Required) 
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Repeat and Triggered Microbial Samples 

1. Additional required information must be submitted when reporting a repeat or triggered sample type. The 
information will associate the repeat/triggered sample to the original positive coliform sample that caused 
the additional monitoring.  

 
Figure 8. Repeat Sample Data Entry Fields 

a. Repeat Location: Enter the repeat location, for example original location, upstream, or downstream. 
This is available for repeat samples only. (Not Required) 

b. Water System ID (Required): This will default to the water system previously selected for the sample. 
c. Sample ID (Required): Choose the sample ID that the sample will be associated with in the dropdown. 

Conditionally required if sample type is repeat or triggered. Note: The original routine coliform positive 
sample must be added to CMDP before entering a repeat or triggered sample. 

Microbial Analytes Results 

1. Click on the “Add” button in the “Microbial Analyte Results” grid to begin adding results for each analyte 
that was analyzed. A row with blank values will be added to the grid. 

a. Analyte (Required): Select the analyte from the dropdown list.  
• 3100 - coliform or 
• 3014 - E. coli  

b. A/P (Required): Enter absent if the analyte result was absent. Enter present if the analyte result was 
present. 

c. Count: Enter the count if an enumeration analytical method was used (Conditionally required if the 
analysis method provides a coliform count, and the sample is Present). 

d. Units: Enter the Units if an enumeration analytical method was used. (Conditionally required) 
e. Volume (ML): Enter the volume if an enumeration analytical method was used. (Conditionally required) 
f. Interference: Enter a reason code if an interference was encountered during analysis. Can only be 

reported when A/P = Present. (Not Required) 
g. Volume Assayed (ML) (Required): Enter the volume of the sample analyzed in MLs. For example, 100 

for microbial samples. 

Figure 9. Adding Microbial Results 
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Figure 10. Adding Microbial Results, continued 

h. Method (Required): Select the method of analysis from the dropdown list.  
i. Analysis Start Date (Required): Enter the date (MM/DD/YYYY) that the analysis began. 
j. Analysis Start Time (24-hr) (Required): Enter the time (HH:MM) that the analysis began. 
k. Analysis Completed Date: Enter the date (MM/DD/YYYY) that the analysis was completed. (Not 

Required)   
l. Analysis Completed Time (24-hr): Enter the time (HH:MM) that the analysis was completed. (Not 

Required)  
m. Analyzing Lab ID: Do NOT report data in this field. Receiving laboratory must report data to TCEQ. 
n. Person Performing Analysis: Enter the name of the person that performed the analysis. (Not Required) 
o. Source Type: Select source type from the dropdown list. (Not Required) 
p. Comments: Enter any additional comments related to the analytical result. (Not Required) 

2. Repeat Step 1 to add each analyte. 

Field Results and Measurements – Required for Chlorine Residual 

A chlorine residual reading must be submitted with each microbial sample. This parameter must be analyzed in the 
field at the time the sample is collected.  

1. Click on the small triangle to the left of the “Field Results and Measurements” section to toggle between 
displaying or hiding the grid. 

2. Click on the “Add” button in the “Field Results and Measurements” grid to add results for each parameter 
that was analyzed in the field. A row with blank values will be added to the grid. 

 
Figure 11. Field Results and Measurements Fields 

3. Enter the information as described below: 
a. Parameter (Required): Select “free chlorine residual” or “total chlorine residual” from the dropdown 

list. 
b. Result (Required): Enter the numerical value of the 

test conducted in the field. 
c. Result UOM (Required): Enter the units of measure 

for the test conducted in the field, for example, mg/L). 
d. Method: Enter the method used for the test conducted in the field. (Not Required) 
e. Person Performing Analysis: Enter the person who performed the analysis in the field. (Not Required) 
f. Comments: Enter any additional comments about the reading. (Not Required) 

4. Click on the “Save” button at the top of the page to save the sample. 

Figure 12. Save Button to Save Samples Entered 
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Entering Chem/Radionuclides 

The “Chem/Radionuclides” option is used for all non-microbial reporting including DBPs, IOCs, SOCs, VOCs, TOCs, 
Nitrates, Lead and Copper Rule (LCR) samples, Water Quality Parameters (WQPs), and Optimal Water Quality 
Parameters (OWQPs). In the Job Summary View tab, click on the “Add” dropdown box and choose “Chem/ 

Radionuclides” from the list. 

Sample Information 

1. Enter the information as described below:  
Note: Chem/Rads samples can come from both Distribution and Non-Distribution.  

a. Water System ID (Required): The seven-digit public water system ID number (PWS ID). This must be 
preceded by TX, which is automatically added by CMDP. Type it in or select from the dropdown list.  

b. Water System Name: The water system name will automatically populate once the PWS ID has been 
entered.  

c. Facility (Required): The water system facility ID number. Select from the dropdown list. 
Common facilities include: 
• DS01 – for samples collected in the distribution, or 
• EP### - for samples collected at the entry point. 
• PBCU### - for Lead/Copper or WQP samples collected at the entry point. 
• Well ID - G1234567A only for raw well samples. 

Figure 14. Entering Chem/Rads Samples into the Web Form 

Figure 13. Job Summary View – Adding Chem/ Rads Samples 
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d. Sampling Point (Required): The sampling point where the sample was collected. Select from the 
dropdown list. 
Common sample points include:  
• From DS01: 

• ASB-## – asbestos samples  
• DBP2-## – for TTHM and HAA5  
• LCR### – for lead and copper  
• DSTWQP – for Water Quality Parameter samples 

• From EP###: 
• ELCR – for lead and copper collected at the entry point 

• TRT-TAP  
• From PBCU###: 

• ELCR – for lead and copper samples 
• EWQP – for Water Quality Parameter samples  

• From Well ID: 
• RAW-TAP – for new well sampling and to confirm groundwater contamination. 

e. Sampling Location (Required): Description of the sampling location (e.g., 123 Main St; kitchen sink, 
etc.). 

f. Sample ID (Required): Sample identification number assigned by the lab. This field is limited to 20 
characters and only numbers, letters, dash (-), and/or underscore. The sample ID must be unique based 
on the lab, the date and WS ID. 

g. Collection Date (Required): Date (MM/DD/YYYY) the sample was collected. 
h. Collection Time (24-hr) (Required): Time (HH:MM) the sample was collected. 
i. Sample Received Date (Required): Date the sample was received by the laboratory. 
j. Laboratory ID – Name (Required): ID and name of the laboratory reporting the sample. 
j. Sample Type (Required): Sample type routine or confirmation sample. Ideally, this information would 

be identified by the sampler. 
k. Sample Volume: Volume of the sample. (Not Required) 
l. Sample Collector Name (Required): Name of the sample collector. 
m. Comment: Enter any additional comments related to the analytical result (Conditionally Required) 

Required if submitting samples with a state sample ID in accordance with state sample contract. State 
sample ID followed by a semicolon (e.g., 1234567;). Additional comments may be added after the 
semicolon. 

Chemical/Radionuclides Analytes Results 

1. Click on the “Add” button in the “Chem/Rads Results” grid to begin adding results for each analyte that was 
analyzed. A row with blank values will be added to the grid. 
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Figure 15. Entering Chem/Rads Results into the Web Form 

a. Analyte (Required): Select the analyte from the dropdown list.  
b. Not Detected (Required): Select the check box if the sample has a non-detect value. CMDP 

automatically checks the “Not Detected” check box.  
c. Result (Required): Enter the numerical value if analyte was detected.  
d. Result UOM (Required if detected): Enter the units of measurement of analyte.  
e. Standard Deviation (+/-): Enter the standard deviation of sample value. (Conditionally Required) 

Required if reporting Radionuclides. 
f. Reporting Limit (Required): Enter the reporting limit of sample analyte.  
g. Reporting Limit UOM (Required): Select the unit of measurement for reporting limit of sample analyte.  
h. Volume Assayed (ML): Enter the volume of the sample that was analyzed. (Not Required) 
i. Method (Required): Select the method of analysis from the dropdown list.  
j. Analysis Start Date (Required): Enter the date that the analysis began. 
k. Analysis Start Time (24-hr) (Required): Enter the time (HH:MM) that the analysis began. 
l. Analysis Completed Date (Required): Enter the date (MM/DD/YYYY) that the analysis was completed.  
m. Analysis Completed Time (24-hr) (Required): Enter the time (HH:MM) that the analysis was 

completed. 
n. Analyzing Lab ID: Do NOT report data in this field. Receiving laboratory must report data to TCEQ. 
o. Person Performing Analysis: Enter the name of the person that performed the analysis. (Not Required)  
p. Comments: Enter any additional comments related to the analytical result. (Conditionally Required). 

Required if reporting a result with a Quality Assurance Project Plan (QAPP) required/approved qualifier.  
 

2. Repeat Step 1 for each analyte to be added. 

Field Results and Measurements – Required for samples with a state sample ID 

A chlorine residual, pH, and temperature reading must be reported with each sample submitted as a part of the 
state sampling contract. These parameters must be analyzed in the field at the time the sample is collected.  

1. Click on the small triangle to the left of the “Field Results and Measurements” section to toggle between 
displaying or hiding the grid. 

2. Click on the “Add” button in the “Field Results and Measurements” grid to add results for each parameter 
that was analyzed in the field. A row with blank values will be added to the grid. See figure 11 for visual aid. 

3. Enter the information as described below: 
a. Parameter (Required): 

• 1013 – free chlorine residual; or 1012 - total chlorine residual; 

Figure 16. Entering Chem/Rads Samples into the Web Form, Continued 
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• 1925 – PH 
• 1996 – Temperature 

b. Select free chlorine residual or total chlorine residual from the dropdown list. 
c. Result (Required): Enter the numerical value of the test conducted in the field. 
d. Result UOM (Required): Enter the units of measure for the test conducted in the field, for example, 

mg/L). 
e. Method: Enter the method used for the test conducted in the field. (Not Required) 
f. Person Performing Analysis: Enter the person who performed the analysis in the field. (Not Required) 
g. Comments: Enter any additional comments about the reading. (Not Required) 

 
4. Click on the “Save” button at the top of the page to save the sample. See figure 12 for visual aid. 
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Entering Data Using Excel Templates 
Users can download an Excel template for sample data entry offline. Samples and sample results are entered into the 
template. The template is used to create an XML file which is then uploaded into CMDP. The template is available on 
the “Home” tab in CMDP. 

Downloading a Template  

1. Navigate to the “Home” tab in CMDP. 
2. Select “Sample Results” from the “Templates” dropdown list. 
3. Select “Download” button to download the Template file.  

Note: Users will need Microsoft Excel installed to open and use the template. 

Template – First Use 

Once the template is downloaded, you may open the Excel file. It is likely that macros will be blocked on the Excel 
template file due to permissions. Macros will need to be enabled before the XML file can be successfully generated. 
Follow the steps below to enable macros.  

 
Figure 18. Macros Blocked Alert on Excel Template 

1. Make sure the CMDP template is saved/located in the folder of your choosing (not only in 
your downloads). 

2. Open Excel.  
3. Find the “Options” tab on the home screen or find using the search bar.  
4. In the “Options” pop-up, find the “Trust Center” in the menu on the left side of the screen. 
5. Select the “Trust Center Settings” button. 

 

Figure 17. Selecting a Template to Download in CMDP 

Figure 19. 
Options button 

in Excel 

Figure 20: Trust Center Setting Option 
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6. Select “Macro Settings” in the menu. 
7. Select the last radio button “Enable VBA Macros (not recommended 

potentially dangerous code can run).”  
8. Select the two remaining checkboxes “Enable Excel 4.0 macros when VBA 

macros are enabled,” and “Trust Access to the VBA project object model.” 

9. Select the menu option “Trusted Locations.” 
10. Add the folder/folders where the templates will be saved into the “Trusted 

Locations” list.  
11. Select “OK.” 
12. Try “Generate XML” button now. If it does not work, close and re-open Excel and 

try again.  

Definitions of the data entry requirements per CMDP notation are shown below. Refer to 
the following sections for descriptions and requirements of each field. 

* - Required: Identifies fields that must contain information to save the sample. 
+ - Conditionally Required: Identifies fields that must contain data if certain conditions are met (e.g., 
reporting a Count, Units and Volume if an enumeration analytical method is used) 
f – Federally Required: Identifies fields that must contain data. These fields are used to determine if a 
sample can be used for compliance. 

f – Federally Conditionally Required: Identifies fields that must contain data if certain conditions are met. 
These fields are used to determine if a sample can be used for compliance. 

There are four “Template” tabs. Ensure you are on the correct tab when you are working: 

• Microbial 
• Chems-Rads 
• Cryptosporidium 
• Notes 

 

Figure 22: Check These Options to Enable Macros 

Figure 23: Trusted Locations 
Menu Option 

Figure 21: Macro Settings 
Option 
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Template Layout 

 
Figure 24. An example of the template header. Will change depending on which tab you are working on. 

a. Reporting Lab. ID (Required): The lab’s ID number is required (i.e., T123456789).  

 

 
Figure 26. An Example of the Top of the Excel Template: Reporting Lab ID & Generate XML Button 

Section 1 - Sample Information 

 
Figure 27. Sample Information Section of Excel Template 

Section 2-Results 

 
Figure 28. Results Section of Excel Template 

Section 3-Field Results & Measurements  

  

Figure 25. An Example of different tabs at bottom of Excel template 

 

Figure 29. Field Results Section of Excel Template 
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Entering Microbial Samples 

Sample Information 

 
Figure 30. Micro Sample Information Section 

a. Sample ID (Required): Sample identification number assigned by the lab. This field is limited to 20 
characters and only numbers, letters, dash (-), and/or underscore. Note: The Sample ID must be unique 
based on the lab, date, and PWS ID. 

b. Sample Received Date (Required): Date (MM/DD/YYYY) the sample was received by the laboratory. 
c. WS ID (Required): The seven-digit public water system ID number (PWS ID). This must be preceded by 

TX, which is automatically added by CMDP. Type it in or select from the dropdown list.  
d. Facility ID (Required): Water system facility ID number. Select from the dropdown list:  

• DS01 – distribution samples, or  
• Well ID - G1234567A only for raw well samples. 

e. Sampling Point ID (Required): Sampling point where the sample was collected. Select from the 
dropdown list: 
• From DS01: 

• DSTCRRT if sample type is routine. 
• DSTCRRP if sample type is repeat. 
• DSTCRSP if sample type is special. 

• From Well ID 
• ASM for raw well assessment source monitoring. 
• TSM for raw well triggered source monitoring (collected in response to a total coliform positive 

distribution sample). 
f. Sampling Location (Required): Description of the sampling location (For example, 123 Main St; Health 

Clinic, kitchen sink, etc.). 
g. Collection Date (Required): Date (MM/DD/YYYY) the sample was collected. 
h. Collection Time (24H) (Required): Time (HH:MM) the sample was collected. 
i. Sample Type (Required): Sample type Routine, Repeat, Triggered, or Special. See the Repeat and 

Triggered Microbial Samples subsection for details on the additional information required for these 
sample types. This would be identified by the sampler. 
• Routine - routine distribution sample collected to fulfill the monthly coliform TCEQ requirement or 

routine raw well sampling for assessment source monitoring,  
• Repeat - repeat distribution sample collected in response to a routine coliform positive sample,  
• Triggered - raw well samples collected in response to a routine coliform positive sample collected 

in distribution.  
• Special – can be used to rescind a boil water notice, as investigative sampling, to meet TCEQ 

seasonal start up requirements, after well disinfection. Special samples cannot be used to meet 
routine, repeat, or triggered sample requirements.  

j. Sample Volume (ML) (Required): Enter the volume of the sample in MLs, for example 100 for microbial 
samples. 
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k. Comment: Comments about the sample. (Not Required) 
l. Repeat Location: Select “Repeat Location” from the dropdown list (e.g., original site, upstream, or 

downstream). This is available for repeat samples only. (Not Required) 

Repeat and Triggered Microbial Samples 

m. Original Sample ID (Required if sample type is “Repeat” or “Triggered”): Sample ID for the original 
sample that tested present/positive. Note: the original routine coliform positive sample must be added 
to CMDP before entering a repeat or triggered sample.  

n. Original Reporting Lab. ID: ID number for the laboratory that tested the original sample that tested 
present/positive. (Not Required) 

o. Original Collection Date: Date (MM/DD/YYYY) of collection of the original sample that tested 
Present/Positive. (Not Required 

p. Comment: Any additional comments. (Not Required) 
q. Sample Collector Name (Required): Sample collector name.  

Results – Micro Samples Template 

 
Figure 32. Micro Sample Results Section 

a. Analyte [Code – Name] (Required): Select the analyte from the dropdown list.  
• 3100 - Total Coliform; or 
• 3014 - E. coli.  

b. A/P (Required): Enter Absent if the analyte result was Absent. Enter Present if the analyte result was 
Present. 

c. Count: Enter the Count if an enumeration analytical method was used (Conditionally required if the 
analysis method provides a coliform count, and the sample is Present). 

d. Units: Enter the Units if an enumeration analytical method was used. (Conditionally required) 
e. Volume (ML): Enter the volume if an enumeration analytical method was used. (Conditionally required) 
f. Interference: Enter a reason code if an interference was encountered during analysis. Can only be 

reported when A/P = Present. (Not Required) 
g. Volume Assayed (ML) (Required): Enter the volume of the sample that was analyzed in MLs, for 

example 100 for microbial samples. 
h.  Method (Required): Select the method of analysis from the dropdown list. 

Figure 31. Micro Sample Information Section, Continued 
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i. Analysis Start Date (Required): Enter the date (MM/DD/YYYY) that the analysis began. 
j. Analysis Start Time (24-hr) (Required): Enter the time (HH:MM) that the analysis began. 
k. Analysis Completed Date: Enter the date (MM/DD/YYYY) that the analysis was completed. (Not 

Required)   
l. Analysis Completed Time (24-hr): Enter the time (HH:MM) that the analysis was completed. (Not 

Required  
m. Analyzing Lab ID: Do NOT report data in this field. Receiving laboratory must report data to TCEQ.  
n. Person Performing Analysis: Enter the name of the person that performed the analysis. (Not Required) 
o. Source Type: Select Source type from the dropdown list. (Not Required) 
p. Comments: Enter any additional comments related to the analytical result. (Not Required) 

Field Results and Measurements 

a. Parameter [Code – Name] (Required): Select the following from the dropdown list: 
1013 - free chlorine residual; or 1012 - total chlorine residual.  

b. Result (Required): Enter the numerical value of the test conducted in the field.  
c. Result UOM (Required): Enter the unit of measurement of the result value.  
d. Method: Enter the method from the dropdown list. (Not Required) 
e. Analyst Name: Enter the person that performed the analysis in the field. (Not Required) 
f. Comment: Enter any additional comments related to the field measurement. (Not Required) 

Entering Chemical/ Radionuclides Samples 

Sample Information 

 
Figure 35. Chem/Rads Sample Information Section 

a. Sample ID (Required): Enter the sample identification number assigned by the lab. The sample ID must 
be unique based on the lab, the date and WS ID. 

b. Sample Received Date (Required): Enter the date (MM/DD/YYYY) the sample was received by the 
laboratory. 

Figure 33. Micro Sample Results, Continued. 

Figure 34. Micro Field Results & Measurements Section 
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c. WS ID (Required): Enter the seven-digit PWS ID number. This must be preceded by TX.  
d. Facility ID (Required): Enter the water system facility ID number. Common facilities include: 

• DS01 – for samples collected in the distribution, or 
• EP### - for samples collected at the entry point. 
• PBCU### - for Lead/Copper or WQP samples collected at the entry point. 
• Well ID - G1234567A only for raw well samples. 

e. Sampling Point ID (Required): Enter the sample point identification number related to the facility 
where the sample was collected. Common sample points include:  
• From DS01: 

• ASB-## – asbestos samples  
• DBP2-## – for TTHM and HAA5  
• LCR### – for lead and copper  
• DSTWQP – for Water Quality Parameter samples 

• From EP###: 
• TRT-TAP  

• From PBCU###: 
• ELCR – for lead and copper samples 
• EWQP – for Water Quality Parameter samples  

• From Well ID: 
• RAW-TAP – for new well sampling and to confirm groundwater contamination. 

f. Sampling Location (Required): Enter a description of the sampling location (e.g.,123 Main St; kitchen 
sink, etc.).   

g. Collection Date (Required): Enter the date (MM/DD/YYYY) the sample was collected. 
h. Collection time (24H) (Required): Enter the time (HH:MM) the sample was collected. 
i. Sample Type (Required): Select the sample type from the dropdown list. Routine or Confirmation or 

Field Blank sample. Ideally would be identified by the sampler. 
j. Sample Volume (ML): Volume of the sample. (Not Required) 
k. Repeat Location: Do NOT report data in this field. 

 
Figure 36. Chem/Rads Sample Information Section, Continued 

l. Original Sample ID: Enter original sample ID (Not Required) 
m. Original Reporting Lab. ID: Enter laboratory information which reported original sample result. (Not 

Required) 
n. Original Collection Date: Enter the collection date (MM/DD/YYYY) for original sample which triggered a 

confirmation sample. (Not Required) 
o. Comment:  Enter any additional comments related to the analytical result (Conditionally Required) 

Required for samples with a State Sample ID in accordance with state sample contract. State Sample 
ID followed by a semicolon (e.g., 1234567;). Additional comments may be added after the semicolon. 

p. Sample Collector Name (Required): Enter the name of the person that collected the sample.  
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Results – Chem/Rads Template 

 
Figure 37. Chem/Rads Sample Results Section 

a. Analyte [Code – Name] (Required): Select analyte code from the dropdown list.   
b. Not Detected (Required): Select from the dropdown list whether the contaminant was “Not Detected” 

(Select “Yes”) or “Detected” (Select “No”) in the analyzed sample. 
c. Result (Required if detected): Enter the numerical value if analyte was detected. 
d. Result UOM (Required if detected): Select the result unit of measurement from the dropdown list if 

applicable.  
e. Standard Deviation (+/-): Enter the standard deviation of sample value for a radionuclides sample. 

(Conditionally required) 
f. Reporting Limit (Required): Enter the laboratory sample reporting limit.  
g. Reporting Limit UOM (Required): Select unit of measurement of laboratory sample reporting limit 

from the dropdown list.  
h. Volume Assayed (ML): Enter the volume of the sample that was analyzed in MLs. (Not Required) 

i. Method (Required): Select method of analysis from the dropdown list.  
j. Analysis Start Date (Required): Enter the date (MM/DD/YYYY) that the analysis began. 
k. Analysis Start Time (Required): Enter the time (HH:MM) that the analysis began. 
l. Analysis Completed Date (Required): Enter the date (MM/DD/YYYY) that the analysis was completed.  
m. Analysis Completed Time (Required): Enter the time (HH:MM) that the analysis was completed.  
n. Analyst Name: Enter the name of the person that performed the analysis. (Not Required) 
o. Analyzing Lab ID: Do NOT report data in this field. Receiving laboratory must report data to TCEQ. 
p. Comment: Report a result with a QAPP required/approved qualifier. (Conditionally Required) 

Field Results and Measurements (Required for samples with State Sample ID) 

See Figure 36 above for visual aid. 

a. Parameter [Code – Name] (Required): Select the following from the dropdown list: 
• 1013 – free chlorine residual; or 1012 - total chlorine residual 
• 1925 – PH 
• 1996 - temperature 

b. Result (Required): Enter the numerical value of the test conducted in the field.  
c. Result UOM (Required): Enter the unit of measurement of the result value.  
d. Method: Enter the method from the dropdown list. (Not Required) 
e. Analyst Name: Enter the person that performed the analysis in the field. (Not Required) 
f. Comment: Enter any additional comments related to the field measurement. (Not Required) 

Generating an XML File 

Figure 38. Chem/ Rads Sample Results Section, Continued 
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1. Once the sample data is appropriately entered (required fields filled in), ensure the “Reporting Lab ID” field 
is also filled in.  

2. Select “Generate XML.” This will open a prompt for this template to be saved. Select the desired location for 
this file to be saved.  

 

3. Select “Save.”  

 
Figure 40. Saving an XML File 

Uploading an XML File To CMDP 

1. Log into CMDP. 
2. On the “Home” tab, ensure your working organization is correct. 
3. Click on the “Drinking Water Sample Jobs” tab at the top of the screen. 
4. Click on the “Create New Job” button at the top of the “Drinking Water Samples Jobs” grid. 
5. Click on “Upload File” on the “Create New Job Options” pop up screen. 

Figure 39. Generate XML Button 
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Figure 41. Creating a New Job and Uploading a File 

6. Click on “Choose a file to upload” in the “Create New Job – Upload Sample File” screen.  
7. Using the file explorer, locate the XML file to upload, highlight it and click on the “Open” button to select the 

file. 

 

Figure 42. Selecting the XML file to Upload 

8. If the file was constructed and read properly, the word “Done” will be displayed in green font. Click the 
“Upload” button to upload the file.  
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Figure 43. CMDP Upload Window Showing “Done” Status 

9. If there are any problems or errors that are preventing the file from being read, the errors will be displayed 
at the top of the screen, as reflected below. The file will need to be corrected and uploaded again. 

 
Figure 44. Error Message During Upload File 

10. If the file was uploaded successfully, a message will display that the Information saved successfully. Click on 
the “Close” button to return to the job maintenance view. 

11. After the file is uploaded, a new job will be created and added to the “Drinking Water Sample Jobs” under 
the “Job Maintenance View” tab in CMDP. While the file is processing, “N/A” will be displayed in the “Total 
Records,” “Records Uploaded” and “Records Not Uploaded” columns.  

12. Click on the “Refresh” button to refresh the display until the number of “Total Records” is displayed. Larger 
files with many samples will take longer to process.  

Figure 45. Successful File Upload 

Figure 46. Job Maintenance View After Upload 
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13. If the “Records Not Uploaded” is greater than zero, or the number of “Total Records” does not equal the 
sum of the “Records Uploaded” + “Records Not Uploaded” review the validation errors. 

14. Click anywhere in the job row to open the “Job Summary View” to view the samples and validations. 

Reviewing Validation Errors 
Users must always review jobs for validation errors prior to submitting the information to the state. To review 
navigate to the “Validations” tab under the “Job Summary View.” 

 
Figure 47. Validations Tab Navigation  

 
Figure 48. Validations Screen Reflecting a Sample Upload that Contains an Error 

1. If there is a sample count in the “With Errors” field, click on the row and refer to the bottom of the page in the 
“XML Submittal Validation Error Details” Section for error descriptions. Some errors may be attributed invalid 
or missing PWS ID, Facility ID, or Sample point ID. See the Public Water System Information section below for 
more information. 

 
Figure 49. An Example of Error Description. Will be Different Depending on Error in Sample Template Uploaded 

2. Correct errors, remove the existing sample job from CMDP, generate a new XML file, and repeat upload until 
there are no errors. 

Ideally, the error will be identified, source data will be corrected, and the file with the error will be removed. 
A new XML can be generated and then uploaded. This will promote data quality and accuracy across 
databases and prevent duplicate sample errors from initial submissions.  

 
Figure 50. Validations Screen Reflecting a Sample Upload That Does Not Contain Any Errors 

3. Since this job now has one job without errors and none with errors, go on to submit the sample job.  
4. Close the “Job Summary View” tab and navigate back to “Drinking Water Sample Jobs” tab. 
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Attaching Documents In CMDP  
1. Select the drinking water sample job which needs the attachment (click in the sample bar, do not select the 

check box).  
2. Select the “Attachments” tab. 

3. Choose a file and select “Upload.” 
4. The selected file should be available to download or remove (select checkbox to execute these options). 

Sending Jobs to the Reviewer 

1. Once you have entered an error free file select the checkbox for the job ready to upload.  
2. Select the “Send to Reviewer” button. This will prompt a dropdown list of administrators who you can send 

to for review.  

 
Figure 53. Sending a Job to Reviewer  

Figure 51. Attachments Tab and Upload Process 

Figure 52. Successful Upload File Available 
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Sending Jobs to the Certifier 
1. Once the status lists “Draft with”, Select the “Send to Certifier” button.  

 
Figure 54. Sending a Job to Certifier 

2. Repeat drop down admin selection process.  

Certifying and Submitting Jobs 
1. Once the status lists “Draft with Certifier,” select the “Certify and Submit to State” button.  

 
Figure 55. Certifying and Submitting a Job 

2. This will prompt you to enter your username and password. Another prompt asking for an answer to your 
security question will appear.  

 
Figure 56. Security Question prompt during submission 

3. Make sure to select the checkbox at the bottom of the screen, then 
the “Submit” button will appear. Select “Submit.”  

4. Your job should now be accepted into CMDP.  

 

Figure 57. Successful Upload Message 
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Public Water System Information  
Users have access to the water system inventory information that is needed to report sample results. The three 
required fields are: Water System ID, Facility ID, and Sampling Point ID (identified below). Users can use this page to 
view necessary information for successful CMDP uploads.  

For example, if a sample is submitted with a certain Facility ID and the laboratory is receiving errors regarding that 
Facility ID, they can look up that PWS here and double check the associated Facility ID and address accordingly. 

Newly activated or modified PWS information is updated in CMDP at least weekly. Any issues with missing or 
incorrect PWS information should be addressed by contacting TCEQ at: PWSINVEN@tceq.texas.gov or by calling 512-
239-4691. 

Figure 58. PWS Inventory Information 
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